OpenOffice v3.x Security Design Weaknesses

Eric Filiol and Jean-Paul Fizaine
ESIEA
Laboratoire de virologie et de cryptologie opérationnelles
38 rue des Dr Calmette et Guérin, 53 000 Laval, France
filiol@esiea.fr, fizaine@esiea-ouest.fr

March 16, 2009

Abstract

For years, document malware exist quite exclusively for Microsoft Office: the sadly known macro-viruses which still represent a numeric nuisance nowadays. However, the recent evolution of office suite towards free software – providing a high compatibility with existing office software – makes it very necessary to determine and evaluate the exact level of risk of the OpenOffice suite with respect to document malware. This paper presents an up to date in-depth evaluation of its security (release 3.0.x) based on the results established since 2006 and 2007. All those results as well as the different sources codes of our attacks have been communicated to the OpenOffice developers group in order to help them to correct the identified security weaknesses and thus enhance the overall security of the OpenOffice suite around the concept of Trusted OpenOffice suite.

While this suite has been developed towards more and more easy-to-useness, the overall security has not been modified at all since. Worrying security weaknesses that have been identified since can still be exploited. They still may be used by malware to spread through innocuous-looking documents by exploiting the feeling of trust based on encryption and digital signature. At the present time, it seems far easier to develop sophisticated document malware for OpenOffice than for Microsoft Office. It is worth mentioning that the attacks we present are NOT based on software (implementation) flaws but on conceptual weaknesses that urge a redesign of the whole software concept.

Finally this paper will discuss the pros and cons of both open and proprietary solutions, on a purely technical basis, as far as security is concerned. There is no such thing as a perfect solution. Therein lies all the complexity of doing computer security.
1 Introduction

The evolution of viral techniques and malware attacks shows that they will occur more and more through office documents. Document malware [8] are formidable attack vectors: users are not suspicious of the documents themselves and a low dose of social engineering is enough to make any user open any document. On the other side, antivirus software are still unable to effectively manage document malware as soon as they are a little bit sophisticated. The analysis of recent cases of espionage or attacks unfortunately demonstrates it dramatically.

In this context, the emergence of new office suites like OpenOffice is a potential boon for the attacker, if security is not there. The case of a macro worm like BadBunny [7] illustrated it particularly. The portability of that office suite on Windows, Unix and Mac environments increases the risk by making it multiplatform. Yet this code was far from exploiting all the weaknesses of this suite.

These conceptual weaknesses have been identified in a number of studies [2, 5, 6] conducted in 2006 and 2007. It was logical at the time of the release of version 3.0 of the suite in October 2008, announced as a major evolution of the suite, to check how these weaknesses had been managed and whether the previously identified attacks were still possible.

For our study, we have considered, without loss of generality, a multiplatform virus written in Python [4]. The goal is not to test the viral algorithmics related to OpenOffice, since it is not conceptually different from that used in Microsoft Office malware – it is just much richer because of the many native programming languages contained in OpenOffice. It is simply related to the general viral algorithmic with respect to document malware [8]. The aim is to test whether the conceptual weaknesses previously identified, mainly related to the management of encryption and digital signature [6] do not still facilitate the attacks and the implementation of those malware when considering the OpenOffice version 3.

Let us briefly recall the attacks and weaknesses that have been identified in 2006 and 2007 [2, 5, 6] for versions 2.x, which were linked to the Open Document Format 1.1.

- Changing the macros management: essentially malware can change and pervert the level of macro security [2, 5].

- Add macros in user space: it was possible to add macros in the user library in the suite. This allowed to embed a resident viral code in
the application. The latter infect any document at the opening for example.

- Modification and manipulation of the menus in the application (undermining the integrity of the application), this weakness is more subtle because it can mislead the user to click too quickly in the same place. In the end, it forces their choice without being realized by the user.

- Integrity, signature and encryption: 2.x versions (ODF 1.0 format) [6] can handle and manipulate the cryptographic functionalities in several ways:
  
  - Unencrypted (plain) document: the lack of integrity control of the file structure makes possible to include any type of information. Files can be added and inserted without having to declare them in the file structure. Accordingly, it is possible for example to introduce executable code (macro virus).
  
  - Encrypted document: the most interesting case relates to macros. Considering an encrypted document with macros, you can either simply remove the macro or replace it with (viral) executable code (viral) in plaintext, at the cost of losing the original code (unless performing an actual malware infection like preprending or appending viral code to the existing macro code), thus without causing any alert at the recipient. It is therefore possible to introduce active code even if the document is encrypted. The attacker uses and pervert the confidence provided by encryption, while increasing the scope of a successful malware attack.
  
  - Digitally signed document: it was possible to remove the signature on both encrypted and unencrypted documents and thus come back to the previous cases.

In this paper, we will look back at those attacks and identify those who are still valid with the OpenOffice version 3. We shall first briefly recall the structure of the ODF format, particularly with respect to encryption and digital signature features, as well as tools used to analyze and manipulate this format. For a more detailed description, the reader will refer to previous publications [2, 5, 6]. Most of the technical information presented here relate to the Apple Mac version. However, what is presented also fully holds under Unices and Windows. Moreover, without loss of generality we will consider the case of odt documents (produced by the OpenOffice
Writer) only. All the results presented in this paper generalizes to any other OpenOffice application.

2 ODF Format and Security Features

Let us note first that according to the official website announcements on OpenOffice [10], the OpenOffice suite already supports version 1.2 of the ODF format. But at the time of writing this article, no official document has yet been published on the oasis website [1]. The site only contains old versions 1.0 and 1.1 of the format. Thus we can expect to find exactly the same weaknesses already identified [2, 5, 6].

2.1 A Formal Approach of OpenOffice Cryptographic Features Use

OpenOffice.org’s security is based on two essential mechanisms: password-based encryption and digital signature. Both supposedly aim at preventing an illegitimate use or manipulation of a document, in the particular context of document malware, any weakness with respect to any of these mechanisms could be exploited in a dramatically powerful way to fool the user’s trust in both cryptographic protections.

Since there exists a lot of way of using encryption and signature to protect an OpenOffice document, we are going to use a formal graph-based approach to describe them all. Every node in our graph describes a user’s action. A given path in our graph will just describe a sequence of such actions to encrypt and/or signed a document. This approach is very powerful at detecting security flaws, in other words the cases where the mechanisms are supposed to have been successfully applied while in reality they are not (the document is not encrypted or not signed contrary to the user’s intent).

Our graph-based formalization aims at identifying weaknesses in the signature process, in particular with respect to the macros. To summarize, we are going to show that signature of document visible content and signature of the macros are mutually exclusive: we cannot signed them at the same time. Using technical examples, we will prove in the subsequent sections that it constitutes a serious design flaw that can be efficiently exploited by malware.

Every node describes a possible status for the document:

- **D**: modified document,
- **MD**: modified document with macro,
• ED: saved document,
• EMD: saved document with macro,
• SED: document is signed and saved,
• MSD: document with a macro added AFTER the document has been signed,
• EMSD: document with a macro added AFTER the document has been signed but BEFORE the document is saved,
• SEMD: signed and saved document with a macro.

Nodes are connected by possibly labelled directed arc. The label describes a user’s command/action applied to the document:

• add M: add a macro,
• save: save document,
• sig 1: sign through the File → Digital Signatures... menu,
• sig 2: sign through Tools → Macros → Digital Signature... menu,
• sig 3: sign through the second bottom right box in the OpenOffice GUI.

The corresponding graph is depicted in Figure 1.

In Figure 1, we notice that the graph is divided into two connected components. A first sub-graph is made up of nodes \{MD, EMD, SEMD\} while the second one contains nodes \{ED, SED, MSD, EMSD\}. This supposes two different possible uses of digital signature that can be applied at any time in the life of the document. However, our experiments have proved that it may be quite different indeed. Let us explain why.

When considering signature AND encryption at the same time, our approach remains essentially the same. The set of nodes is generalized as follows:

• D: modified document,
• MD: modified document with macro,
• (SE)MD: encrypted and saved document with macro,
Figure 1: Formal description of digital signature use under OpenOffice
• **S(SE)MD**: signed, encrypted and saved document with a macro,
• **(SE)D**: encrypted and signed document,
• **M(E)D**: a macro is added to an encrypted and saved document,
• **SM(E)D**: a macro is added to an encrypted, saved and finally signed document,
• **S(SE)D**: modified document which has been saved, encrypted and signed,
• **MS(E)D**: a macro is added to an encrypted and signed document,
• **EMS(E)D**: a macro then encrypted document with macro,

We thus obtain the graph depicted in Figure 2. It is very powerful at identifying potential misuses of digital signature in OpenOffice. Such misuses could be potentially by malware as we will show it in the next sections. Two classes of design flaws have been identified. The first class deals with the lack of OpenOffice efficient built-in document integrity management. The second class refers to problems that may occur when macros and/or document are signed. We will not discuss the critical of trust macros. They are presented in [2].

### 2.2 ZIP and ODF Format and Manipulation Tools

Without loss of generality, we will consider command-line tools for Unix-like environments. Of course, there exist equivalent tools under Windows. However, Unix-like environments are more friendly to use and provide a better access for the reader who intends to reproduce the different examples presented hereafter.

A first command is the `file` command which enables to verify that an OpenOffice document has the OpenDocument format type.

```plaintext
File command output
new-host-2:Format lrv\$ file document1.odt
document1.odt: OpenDocument Text
```

Let us recall that in previous OpenOffice version, the file format was the `zip` format. But if we analyze the first few bytes of the file described in the listing given just hereafter, we can however confirm that it is indeed still a `zip` format.
Figure 2: Formal description of encryption AND digital signature use under OpenOffice
The character string `PK 003 004` indeed betrays the ZIP format (refer to the file `/usr/share/file/magic.mime`, line 303). This information is confirmed in the `/usr/share/file/magic` file: any OpenOffice.org, KOffice and StarOffice file are simple ZIP files. The following extract of this file provide additional informations:

<table>
<thead>
<tr>
<th>Offset (bytes)</th>
<th>Data Type</th>
<th>Document Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000000</td>
<td>PK 003 004</td>
<td>Text</td>
</tr>
<tr>
<td>0000012</td>
<td></td>
<td>Template</td>
</tr>
<tr>
<td>0000052</td>
<td>vnd.oasis.opendocument.Text</td>
<td></td>
</tr>
<tr>
<td>0000062</td>
<td>vnd.oasis.opendocument.Text</td>
<td>Text</td>
</tr>
<tr>
<td>0000072</td>
<td>vnd.oasis.opendocument.Text</td>
<td>Template</td>
</tr>
<tr>
<td>0000082</td>
<td>vnd.oasis.opendocument.Text</td>
<td>Master Document</td>
</tr>
<tr>
<td>0000092</td>
<td>vnd.oasis.opendocument.Text</td>
<td>HTML Document</td>
</tr>
<tr>
<td>0000102</td>
<td>vnd.oasis.opendocument.Text</td>
<td>Template</td>
</tr>
<tr>
<td>0000112</td>
<td>vnd.oasis.opendocument.Text</td>
<td>Template</td>
</tr>
<tr>
<td>0000122</td>
<td>vnd.oasis.opendocument.Text</td>
<td>Template</td>
</tr>
<tr>
<td>0000132</td>
<td>vnd.oasis.opendocument.Text</td>
<td>Template</td>
</tr>
<tr>
<td>0000142</td>
<td>vnd.oasis.opendocument.Text</td>
<td>Template</td>
</tr>
<tr>
<td>0000152</td>
<td>vnd.oasis.opendocument.Text</td>
<td>Template</td>
</tr>
</tbody>
</table>

The first column represents the offset (in bytes) from the beginning of the file. The second column defines the data type. The two last columns are of higher interest to us since they contain the document type. At the time of writing, these data hold for the OpenOffice 3.x release only.

The next command to consider enables to definitively confirm the format and document types.
It is worth mentioning that there exist a project whose goal is to provide a set of tools to directly and transparently handle and manipulate the OpenDocument format. The very final aim is to make the zip format as transparent as possible for the developer. This project is denoted odf toolkit [9].

2.3 OpenDocument Format Structure

As a first experiment, let us consider a sample document which contains the text *Test file... only*. We will encrypt it, then we will digitally sign it. For comparison purposes, we will then revert the order of those cryptographic functionalities.

To first decompress an OpenDocument format document, we simply use the `unzip` command as follows:

```
unzip -d rep file.odt
```

The `-d` option just enables to decompress the file in a specified directory.

```
new-host-2:Format lrv$ unzip -d Document1 document1.odt
Archive: document1.odt
extracting: Document1/mimetype
    creating: Document1/Configurations2/statusbar/
    inflating: Document1/Configurations2/accelerator/current.xml
    creating: Document1/Configurations2/floater/
    creating: Document1/Configurations2/popupmenu/
    creating: Document1/Configurations2/progressbar/
    creating: Document1/Configurations2/menubar/
    creating: Document1/Configurations2/toolbar/
    creating: Document1/Configurations2/images/Bitmaps/
    inflating: Document1/content.xml
    inflating: Document1/styles.xml
extracting: Document1/meta.xml
    inflating: Document1/Thumbnails/thumbnail.png
    inflating: Document1/settings.xml
    inflating: Document1/META-INF/manifest.xml
```

The `ls-lR` command provides a detailed view of the content.

```
new-host-2:Format lrv$ ls-lR Document1
```

The OpenDocument archive content
new-host-2:Format lrv$  ls -lR Document1

ls -lR Document1

```
total 64
  drwxr-xr-x 10 lrv lrv 340 30 nov 22:40 Configurations2
  drwxr-xr-x  3 lrv lrv 102 30 nov 22:40 META-INF
  drwxr-xr-x  3 lrv lrv 102 30 nov 22:40 Thumbnails
  -rw-r--r--  1 lrv lrv 2726 30 nov 18:06 content.xml
  -rw-r--r--  1 lrv lrv  866 30 nov 18:06 meta.xml
  -rw-r--r--  1 lrv lrv  39 30 nov 18:06 mimetype
  -rw-r--r--  1 lrv lrv  7992 30 nov 18:06 settings.xml
  -rw-r--r--  1 lrv lrv 10615 30 nov 18:06 styles.xml
Document1/Configurations2:
total 0
  drwxr-xr-x  3 lrv lrv 102 30 nov 22:40 accelerator
  drwxr-xr-x  2 lrv lrv  68 30 nov 18:06 floater
  drwxr-xr-x  3 lrv lrv 102 30 nov 22:40 images
  drwxr-xr-x  2 lrv lrv  68 30 nov 18:06 menubar
  drwxr-xr-x  2 lrv lrv  68 30 nov 18:06 popupmenu
  drwxr-xr-x  2 lrv lrv  68 30 nov 18:06 progressbar
  drwxr-xr-x  2 lrv lrv  68 30 nov 18:06 statusbar
  drwxr-xr-x  2 lrv lrv  68 30 nov 18:06 toolbar

Document1/Configurations2/accelerator:
total 0
  -rw-r--r--  1 lrv lrv  0 30 nov 18:06 current.xml

Document1/Configurations2/floater:

Document1/Configurations2/images:
total 0
  drwxr-xr-x  2 lrv lrv  68 30 nov 18:06 Bitmaps

Document1/Configurations2/images/Bitmaps:

Document1/Configurations2/menubar:

Document1/Configurations2/popupmenu:

Document1/Configurations2/progressbar:

Document1/Configurations2/statusbar:
```
At the very first look, we notice that the structure is quite complex and that there is a number of directories. Official documentation explains that the META-INF/manifest.xml file describes the whole file structure while the document apparent content (payload) is located in the content.xml file (see listing on the next page).
The only significant difference with the former version of the format relates to the use of a different file extension. Every file in the archive have the xml extension. From the document1.odt structure and the OpenDocument documentation, we have built the file organization tree given in Figure 3.
Figure 3: OpenDocument File Internal Structure Tree (here for the Sans nom 1.odt document)
2.3.1 Role of the manifest.xml file

This file somehow plays the role of spinal column for the OpenDocument format. It completely describes files and directories within the ZIP file. To illustrate this, let us consider the following listing with respect to our sample file:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<manifest:manifest xmlns:manifest="urn:oasis:names:tc:opendocument:xmlns:manifest:1.0" manifest:media-type="application/vnd.oasis.opendocument.text" manifest:version="1.2"
    manifest:full-path="/"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/statusbar/"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/accelerator/current.xml"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/accelerator/"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/floater/"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/popupmenu/"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/progressbar/"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/menubar/"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/toolbar/"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/images/Bitmaps/"/>
<manifest:file-entry manifest:media-type="" manifest:
    full-path="Configurations2/images/"/>
<manifest:file-entry manifest:media-type="application/vnd.sun.xml.ui.configuration" manifest:
    full-path="Configurations2/">
<manifest:file-entry manifest:media-type="text/xml" manifest:
    full-path="content.xml"/>
<manifest:file-entry manifest:media-type="text/xml" manifest:
    full-path="styles.xml"/>
<manifest:file-entry manifest:media-type="text/xml" manifest:
    full-path="meta.xml"/>
```
It is worth mentioning that all attacks identified with respect to the OpenOffice version 2.x [2, 6, 5], have been realized by precisely modifying/manipulating the manifest.xml

### 2.3.2 Macro location

Let us now consider how the OpenDocument format manages the most critical part in terms of security: the (in)famous macros. We have added a macro to the previous sample document, whose task, without loss of generality, consists just in displaying the classical message "Hello World" in a message box. For clarity sake’s and once again without loss of generality, this macro is not attached to any event and its security level has not been modified. For more details about those aspects the reader will refer to [2].

We obtain the following listing in which the location of macros is described (use the command `unzip -d doc_macro_dir doc_macro.odt`).

```
New-host-2:Format lrv$ unzip -d doc_macro_dir doc_macro.odt
Archive:  doc_macro.odt
extracting:  doc_macro_dir/mimetype
  creating:  doc_macro_dir/Configurations2/statusbar/
  inflating:  doc_macro_dir/Configurations2/accelerator/current.xml
  creating:  doc_macro_dir/Configurations2/floater/
  creating:  doc_macro_dir/Configurations2/popupmenu/
  creating:  doc_macro_dir/Configurations2/progressbar/
  creating:  doc_macro_dir/Configurations2/menubar/
  creating:  doc_macro_dir/Configurations2/toolbar/
  creating:  doc_macro_dir/Configurations2/images/Bitmaps/
  inflating:  doc_macro_dir/content.xml
  inflating:  doc_macro_dir/Basic/Standard/Hello.xml
  inflating:  doc_macro_dir/Basic/Standard/script-lb.xml
  inflating:  doc_macro_dir/Basic/script-lc.xml
  inflating:  doc_macro_dir/styles.xml
extracting:  doc_macro_dir/meta.xml
inflating:  doc_macro_dir/Thumbnails/thumbnail.png
```
Compared to the same document without macro, we have now three new files (marked in red color in the previous listing):

- `hello.xml`,
- `script-lb.xml`,
- `script-lc.xml`.

We notice that a new directory, denoted `Basic`, has been created as well. It contains the `script-lc.xml` file whose content is given hereafter:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE library:libraries PUBLIC "-//OpenOffice.org//DTD Office Document 1.0//EN" "libraries.dtd">
  <library:library library:name="Standard" library:link="false"/>
</library:libraries>
```

This file gives a few information about the macro, its relevant library, its directory location within the archive... The `Basic/Standard/script-lb.xml` file (see content hereafter) gives additional information about the macro, including very interesting data related to the document security whose obvious nature does not require further comments:

- `library:readonly="false"`
- `library:passwordprotected="false"`

This just implies that simple text manipulations of this file enables to dramatically change the security status of the document. This is of critical interest for malware actions.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE library:library PUBLIC "-//OpenOffice.org//DTD OfficeDocument 1.0//EN" "library.dtd">
```
Finally, the macro content itself (the code) is contained in the last file Hello.xml.

```
Sub Main
    msgbox("Hello World")
End Sub
```

### 2.3.3 Document encryption

The official documentation for the OpenDocument format 1.1 mentions that the encryption algorithm used in the suite is the **Blowfish** algorithm in CFB mode (**Cipher Feedback Mode**). As for the integrity management, the SHA-1 primitive has been considered along a 64-bit encoding.

Let us consider a first OpenOffice encrypted document, without any macro. It is very surprising to notice that the manifest.xml file is itself not encrypted as shown in the listing hereafter. Indeed this file contains the whole archive structure description, which is a critical information for any malware action.

```
<?xml version="1.0" encoding="UTF-8"?>
<manifest:manifest xmlns:manifest="urn:oasis:names:tc:opendocument:xmlns:manifest:1.0">
    <manifest:file-entry manifest:media-type="application/vnd.oasis.opendocument.text" manifest:version="1.2" manifest:full-path="/"/>
</manifest:manifest>
```

Interestingly, it is not the AES which has been chosen!
As this listing clearly shows, a significant number of interesting informa-
ation are then directly available:

- the encryption mechanism itself and its operating way with respect to the integrity management,
- data with respect to the encryption initialization vector (IV) used to differentiate the base key,
- the key derivation algorithm (PBKDF2) and iteration number (1,024), the seed (random value generated for every new encryption)...

Whenever we apply encryption to an OpenOffice document with macros (see listing given hereafter), every file implied in the macro management are themselves encrypted.

___ manifest.xml file of an encrypted document with macros ___

```xml
<?xml version="1.0" encoding="UTF-8"?>
<manifest:manifest xmlns:manifest="urn:oasis:names:tc:opendocument:manifest:1.0">
  <manifest:file-entry manifest:media-type="application/vnd.oasis.opendocument.text" manifest:version="1.2" manifest:full-path="/"/>
  <manifest:file-entry manifest:media-type="" manifest:full-path="Configurations2/statusbar/"/>
  <manifest:file-entry manifest:media-type="" manifest:full-path="Configurations2/accelerator/current.xml" manifest:size="0">
    <manifest:encryption-data manifest:checksum-type="SHA1/1K" manifest:checksum="aIk0hF8iBJyxRmiDLvoz1FATtrk=">
      <manifest:algorithm manifest:algorithm-name="Blowfish CFB" manifest:initialisation-vector="voDWT2nmCI="/>
      <manifest:key-derivation manifest:key-derivation-name="PBKDF2" manifest:iteration-count="1024" manifest:salt="tGw7GCUGjGeC190xJs5A="/>
    </manifest:encryption-data>
  </manifest:file-entry>
  <manifest:file-entry manifest:media-type="" manifest:full-path="Configurations2/accelerator/current.xml" manifest:size="0">
    <manifest:encryption-data manifest:checksum-type="SHA1/1K" manifest:checksum="aIk0hF8iBJyxRmiDLvoz1FATtrk=">
      <manifest:algorithm manifest:algorithm-name="Blowfish CFB" manifest:initialisation-vector="voDWT2nmCI="/>
      <manifest:key-derivation manifest:key-derivation-name="PBKDF2" manifest:iteration-count="1024" manifest:salt="tGw7GCUGjGeC190xJs5A="/>
    </manifest:encryption-data>
  </manifest:file-entry>
  <manifest:file-entry manifest:media-type="" manifest:full-path="Configurations2/accelerator/current.xml" manifest:size="0">
    <manifest:encryption-data manifest:checksum-type="SHA1/1K" manifest:checksum="aIk0hF8iBJyxRmiDLvoz1FATtrk=">
      <manifest:algorithm manifest:algorithm-name="Blowfish CFB" manifest:initialisation-vector="voDWT2nmCI="/>
      <manifest:key-derivation manifest:key-derivation-name="PBKDF2" manifest:iteration-count="1024" manifest:salt="tGw7GCUGjGeC190xJs5A="/>
    </manifest:encryption-data>
  </manifest:file-entry>
</manifest:manifest>
```
The macro file itself is encrypted:

```
Contenu de la macro Hello.xml
```

As a first conclusion, we see that the protection of the `manifest.xml` file is not sufficient. Despite the fact that the document seems to use strong digital signature, partly for strong integrity purposes, we will show in Section 5 that this protection can be easily bypassed.

### 2.3.4 Digital signature of documents

In order to identify and locate the different components involved in the digital signature, we will proceed in the same way as for encryption (refer to the previous section). Let us first consider a document without and then with macro. In OpenOffice 2.x versions, the digital signature was managed at the `Firefox` browser level. For that purpose, it has required to add an environment variable to OpenOffice.org in order to set up the certificate management service (site). It was necessary to import a valid PKCS12 certificate into the browser. Finally, it was possible to digitally sign a document before saving the document.

In the newly released version (OpenOffice.org v3.x), quite almost nothing has changed from a functional point of view. The signature management tools are still located either in the `Tools → Macros → Digital Signature...` menu or in the `File → Digital Signature...` menu (see Section 2.3.6). Once a document has been signed, a dedicated symbol appears in the bottom middle of the application (see Figure 4.

The analysis of the archive files shows (see listing hereafter) that the information with respect to the signature are located in an additional file which is not the `manifest.xml` file.
Je suis un document signé qui va être modifié pour découvrir le secret de la référence inconnue...
Digitally signed document without

ZZR:sig_ss_macro lrv$ unzip -d doc_ss_macro_nchiff_dir
doc_ss_macro_nchiff.odt
Archive: doc_ss_macro_nchiff.odt
extracting: doc_ss_macro_nchiff_dir/mimetype
creating: doc_ss_macro_nchiff_dir/Configurations2/statusbar/
inflating: doc_ss_macro_nchiff_dir/Configurations2/accelerator/
current.xml
creating: doc_ss_macro_nchiff_dir/Configurations2/floater/
creating: doc_ss_macro_nchiff_dir/Configurations2/progressbar/
creating: doc_ss_macro_nchiff_dir/Configurations2/menubar/
creating: doc_ss_macro_nchiff_dir/Configurations2/toolbar/
creating: doc_ss_macro_nchiff_dir/Configurations2/images/Bitmaps/
inflating: doc_ss_macro_nchiff_dir/META-INF/
documentsignatures.xml
inflating: doc_ss_macro_nchiff_dir/content.xml
inflating: doc_ss_macro_nchiff_dir/styles.xml
extracting: doc_ss_macro_nchiff_dir/meta.xml
inflating: doc_ss_macro_nchiff_dir/Thumbnails/thumbnail.png
inflating: doc_ss_macro_nchiff_dir/settings.xml
inflating: doc_ss_macro_nchiff_dir/META-INF/manifest.xml
ZZR:sig_ss_macro lrv$

All the information are located in the META-INF/documentsignatures.xml file. At the beginning of this file the SignatureMethod tag indicates which signature algorithm is used: rsa-sha1 algorithm. For every file described by the Reference tag, there are two additional tags:

1. the DigestMethod tag for the integrity algorithm,
2. the DigestValue which contains the hashh value itself.

Then, we find the certificate details with respect to the document signer (within the KeyInfo tags): name, town, email address of the certificate owner. Finally the X509 certificate itself follows in the X509Certificate. The certificate is reproduced three times. Here follows the corresponding listing for illustration purposes:

<?xml version="1.0" encoding="UTF-8"?>
<documentsignatures xmlns="urn:oasis:names:tc:opendocument: xmlns:digitalsignature:1.0">
The following files only of the archive are digitally signed:

- Configurations2/accelerator/current.xml,
- content.xml,
- style.xml,
- meta.xml,
It is worth mentioning that the META-INF/manifest.xml and META-INF/documentsignatures.xml themselves are not signed. This constitutes a dramatic weakness as we will see later. However, there is another strange reference (enlightened in orange in the previous listing) which seems to relate in a way or another to the META-INF/manifest.xml file. A detailed analysis in fact shows that it is actually a self-reference of the file to itself, in order to recursively managed its own integrity. But this does not constitutes a limitation when perverting the signature.

Figure 5: Structural graph of the documentsignatures.xml file structure

The digital signature relies on the XML-DSIG norm [3]. However, it is itself not standardized in the OpenDocument format release 1.2 (at the
present time no more information is available and the only reference is the version 1.1 [1]) yet. To summarize the complex organization and structure within the documentsignature.xml, we have established its structural graph given in Figure 5. It models both the information hierarchy and the relationships existing between a file and its integrity value (arcs in red color).

From the analysis of the OpenOffice source code related to the digital signature management, we can summarize the main steps operated whenever a document is signed:

1. The signer certificate which has been selected is checked and loaded.

2. The aSignatureHelper.AddForSigning primitive is called from Current/xmlsecurity/source/helper/xmlsignaturehelper.cxx.

3. The mpXSecController->signAStream primitive is then called from Current/xmlsecurity/source/helper/xseccsign.cxx.

4. The m_vInternalSignatureInformations[index].addReference primitive is called from Current/xmlsecurity/source/helper/xsecctl.hxx.

5. Call of the aSignatureHelper.CreateAndWriteSignature primitive from Current/xmlsecurity/source/helper/xmlsignaturehelper.cxx.


7. Insertion of signature WriteSignature from Current/xmlsecurity/source/helper/xseccsign.cxx in the previous document instance.

8. Formatting step by calling the prepareSignatureToWrite primitive, then call of the exportSignature primitive from Current/xmlsecurity/source/helper/xsecctl.hxx.

The different structures used to store all the information related to the signature process are located in /Current/xmlsecurity/inc/xmlsecurity/struct.hxx. The SignatureReferenceInformation structure stores the integrity value for a given file. The struct SignatureInformation structure stores all those generated during the signature, in particular SignatureReferenceInformations vSignatureReferenceInfors which is itself a list.
of SignatureReferenceInformation structures. The rtl::OUString ou-
SignatureValue variable contains the signature value itself. All the aspects
related to signature could be interesting for any malware which would oper-
ate directly in memory and could thus manipulate the signature during its
production.

As a conclusion, the digital signature in OpenOffice 3.x is only partially
secure: while it complies with signature standards, it is far from being cor-
correctly and securely implemented: the critical files are not encrypted and
critical data can be accessed very easily.

2.3.5 Digital signature combined with encryption

Whenever a document is both signed and encrypted, the overall structure
remains the same. The slight difference lies in the fact that the integrity
value is computed from the encrypted version of the files. However, we
have noticed that the META-INF/documentsignatures.xml file is itself not
encrypted.

manifest.xml file content of a signed, encrypted document without macro

<?xml version="1.0" encoding="UTF-8"?>
<manifest:manifest xmlns:manifest="urn:oasis:names:tc:opendocument:
xmlns:manifest:1.0"
<manifest:file-entry manifest:media-type="application/vnd.oasis.
opendocument.text" manifest:version="1.2" manifest:full-path="/"/>
<manifest:file-entry manifest:media-type="" manifest:full-path=
"Configurations2/statusbar/"/>
<manifest:file-entry manifest:media-type="" manifest:full-path= 
"Configurations2/accelerator/current.xml" manifest:size="0"/>
<manifest:encryption-data manifest:checksum-type="SHA1/1K"
manifest:checksum="aIk0hF8iBJyxRmiDLvoz1FATtrk=">
<manifest:algorithm manifest:algorithm-name="Blowfish CFB"
manifest:initialisation-vector="0gPf8zzjzwv="/>
<manifest:key-derivation manifest:key-derivation-name="PBKDF2"
manifest:iteration-count="1024" manifest:salt="YQsPcGEEtDwiz6Aly50vsw="/>
</manifest:encryption-data>
</manifest:file-entry>
<manifest:file-entry manifest:media-type="" manifest:full-path=" 
"Configurations2/accelerator/"/>
<manifest:file-entry manifest:media-type="" manifest:full-path=" 
"Configurations2/floater/"/>
<manifest:file-entry manifest:media-type="" manifest:full-path=" 
"Configurations2/popupmenu/"/
<manifest:file-entry manifest:media-type="" manifest:full-path=" 
"Configurations2/configures/"/>
"Configurations2/progressbar"/
<manifest:file-entry manifest:media-type="" manifest:full-path="Configurations2/menubar"/>
<manifest:file-entry manifest:media-type="" manifest:full-path="Configurations2/toolbar"/>
<manifest:file-entry manifest:media-type="" manifest:full-path="Configurations2/images/Bitmaps"/>
<manifest:file-entry manifest:media-type="" manifest:full-path="Configurations2/images"/>
<manifest:file-entry manifest:media-type="application/vnd.sun.xml.ui.configuration" manifest:full-path="Configurations2/">
<manifest:file-entry manifest:media-type="" manifest:full-path="META-INF/documentsignatures.xml"/>
<manifest:file-entry manifest:media-type="" manifest:full-path="META-INF/"/>
<manifest:file-entry manifest:media-type="text/xml" manifest:full-path="content.xml" manifest:size="2761">
<manifest:encryption-data manifest:checksum-type="SHA1/1K" manifest:checksum="bC4i5ZGRXrj75cKbDJab1J2hsUY=">
<manifest:algorithm manifest:algorithm-name="Blowfish CFB" manifest:initialisation-vector="SOV70HUn4Oo=">
<manifest:key-derivation manifest:key-derivation-name="PBKDF2" manifest:iteration-count="1024" manifest:salt="2o0Qx0jrJ/TCpmaBudig="/>
</manifest:encryption-data>
</manifest:file-entry>
<manifest:file-entry manifest:media-type="text/xml" manifest:full-path="styles.xml" manifest:size="10615">
<manifest:encryption-data manifest:checksum-type="SHA1/1K" manifest:checksum="o/VqxYDQkIkzjMLefhKth3g=">
<manifest:algorithm manifest:algorithm-name="Blowfish CFB" manifest:initialisation-vector="u97RW7vYTUE="/>
<manifest:key-derivation manifest:key-derivation-name="PBKDF2" manifest:iteration-count="1024" manifest:salt="Z6MYPg4I+bldkLEOC1vP8A=="/>
</manifest:encryption-data>
</manifest:file-entry>
<manifest:file-entry manifest:media-type="text/xml" manifest:full-path="meta.xml" manifest:size="866">
<manifest:encryption-data manifest:checksum-type="SHA1/1K" manifest:checksum="KTbc6tsUw6ipNwxrGNwb2ENgbcY=">
<manifest:algorithm manifest:algorithm-name="Blowfish CFB" manifest:initialisation-vector="9WKOPpBB8Ps="/>
<manifest:key-derivation manifest:key-derivation-name="PBKDF2" manifest:iteration-count="1024" manifest:salt=}

33
Additionally, the documentsignatures.xml is still not encrypted. This is worth noticing since it is a major weakness which will enable us to build powerful attacks (see further).

2.3.6 Signature and macros

Let us now consider the case of documents with macros. The following listing clearly shows that the file relating to macros are signed, that is to say:

- Basic/Standard/Helloword.xml,
- Basic/Standard/script-lb.xml,
- Basic/script-lc.xml.
Macros are signed BUT the documentsignatures.xml is itself neither encrypted nor signed. Let us go deeper inside the signature management of document with macros. We are going to check whether there is a significant evolution from OpenOffice 2.x to OpenOffice 3.x. In [6], serious weaknesses have been identified. Indeed, digital signature was only applying to the document content only. Macros themselves were not signed. As a consequence, it was possible to replace a macro with another (possibly malicious) macro, without triggering any integrity violation alert.
In OpenOffice 3.x, there are still two ways to digitally sign a document. The first one is to use the File → Digital Signature... menu while the second one considers the Tools → Macro → Digital Signature... menu. According to the method used, there are significant differences inside the corresponding archive. In the first case, the information with respect to signature are located in the META-INF/documentsignature.xml while in the second case, the signature process stores them into the META-INF/macrosignature.xml.

Comparison between the signature methods (documents without macros)

ZZR:CreationSig lrv$ unzip -d doc_sig2_ss_mac_dit
doc_sig2_ss_mac.odt
Archive: doc_sig2_ss_mac.odt
extracting: doc_sig2_ss_mac_odt/mimetype
creating: doc_sig2_ss_mac_odt/Configurations2/statusbar/
inflating: doc_sig2_ss_mac_odt/Configurations2/accelerator/current.xml
creating: doc_sig2_ss_mac_odt/Configurations2/floater/
creating: doc_sig2_ss_mac_odt/Configurations2/popupmenu/
creating: doc_sig2_ss_mac_odt/Configurations2/progressbar/
creating: doc_sig2_ss_mac_odt/Configurations2/menubar/
creating: doc_sig2_ss_mac_odt/Configurations2/toolbar/
inflating: doc_sig2_ss_mac_odt/META-INF/macrosignatures.xml
inflating: doc_sig2_ss_mac_odt/content.xml
extracting: doc_sig2_ss_mac_odt/styles.xml
inflating: doc_sig2_ss_mac_odt/META-INF/manifest.xml

ZZR:CreationSig lrv$ unzip -d doc_sig1_ss_mac_dir
doc_sig1_ss_mac.odt
Archive: doc_sig1_ss_mac.odt
extracting: doc_sig1_ss_mac_odt/mimetype
creating: doc_sig1_ss_mac_odt/Configurations2/statusbar/
inflating: doc_sig1_ss_mac_odt/Configurations2/accelerator/current.xml
creating: doc_sig1_ss_mac_odt/Configurations2/floater/
creating: doc_sig1_ss_mac_odt/Configurations2/popupmenu/
creating: doc_sig1_ss_mac_odt/Configurations2/progressbar/
creating: doc_sig1_ss_mac_odt/Configurations2/menubar/
creating: doc_sig1_ss_mac_odt/Configurations2/toolbar/
creating: doc_sig1_ss_mac_odt/Configurations2/images/Bitmaps/
When exploring deeper into those two files, differences are noticeably more important. Whenever the signature is applied through the Tools → Macros ... menu, there is no signature component or information with respect to the files of the archive. This means that if the user sign wrongly signs the document when no macro is present (just mistaken the two methods), the document is in fact no protected. This is a major design weakness.

META-INF/macrosignatures.xml file content

```
<?xml version="1.0" encoding="UTF-8"?>
<document-signatures xmlns="urn:oasis:names:tc:opendocument:xmlns:digitalsignature:1.0"><Signature xmlns="http://www.w3.org/2000/09/xmldsig#" Id="ID_00ef00da00e5006600ac00c4004b006a0a4005a0a4008f008100950042005f"><SignedInfo><CanonicalizationMethod Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/></SignedInfo><SignatureMethod Algorithm="http://www.w3.org/2000/09/xmldsig#rsa-sha1"/><Reference URI="#ID_00e7006700d4008f00d7006c004a005a00032001b006500fd00c70084009c"/><DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/><DigestValue>XYRZWS27mS5/uHZ7QzhHVhHYBnIQ=</DigestValue></Reference></Signature><KeyInfo><X509Data><X509IssuerSerial><X509IssuerName>E=jpfizaine@gmail.com,CN=Fizaine,OU=virology research,O=lr,v,ST=France,C=FR</X509IssuerName><X509SerialNumber>14423087784341907841</X509SerialNumber></X509IssuerSerial><X509Certificate>MIIDnDCCAwWgAwIBAgIJAMgpGexN+amBMA0GCSqSIb3DQE
BBAUAMIGRMQswCQYDVQQGEwJGUjEPMA0GA1UECBMGRnJhbmlNMRExdwYDVQQHEw
[..........................]8T7sr7erG+EKwksN8Iyo9XHai6B8K9m0X06BfW2KkYSx8WXf1++C3dWct01pFg==</X509Certificate></X509Data></KeyInfo></document-signatures>```


This is to be compared to the first method (File → Digital Signature...):

<?xml version="1.0" encoding="UTF-8"?>
It is obvious that signature is actually protecting the document in the case of the 
File → Digital Signature... method only. But it is worth mentioning that it is an apparent protection as we will show it in Section 5.

Now what about document containing macros? With the first method (File → Digital Signature...), the whole document content is signed, including existing macros. This is a significant evolution since in OpenOffice 2.x, macros themselves were not signed. As a consequence, attacks identified
in [6] are no longer working, at least directly. But as we will see in Section 5, it is still possible to bypass the signature use by *man-in-the-middle* attacks.

```xml
<?xml version="1.0" encoding="UTF-8"?>
<document-signatures xmlns="urn:oasis:names:tc:opendocument:xmlns:digitalsignature:1.0">
  <Signature xmlns="http://www.w3.org/2000/09/xmldsig#" Id="ID_009400270095003e006c007d004d00e7009000e0000e800de0d400f3000a0015">
    <SignedInfo>
      <CanonicalizationMethod Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
      <SignatureMethod Algorithm="http://www.w3.org/2000/09/xmldsig#rsa-sha1"/>
      <Reference URI="Configurations2/accelerator/current.xml">
        <DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
        <DigestValue>2jmj715rSw0yVb/vlWAYyK/YBwk="</DigestValue>
      </Reference>
      <Reference URI="content.xml">
        <DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
        <DigestValue>YKbZUeCcs0fJHmvT75X3PQurqw0</DigestValue>
      </Reference>
      <Reference URI="Basic/Standard/script-lb.xml">
        <DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
        <DigestValue>QT+KDg92khkio8BypiQmQZhKVQQ</DigestValue>
      </Reference>
      <Reference URI="Basic/Standard/Mess.xml">
        <DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
        <DigestValue>QT+KDg92khkio8BypiQmQZhKVQQ</DigestValue>
      </Reference>
    </SignedInfo>
  </Signature>
</document-signatures>
```
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>xebEZyd10w0yLL6wp9QELPl+UEY="</DigestValue>
</Reference>

<Reference URI="styles.xml">
<Transforms>
  <Transform Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
</Transforms>
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>6j3xV90oFUv9fjP6SttOikQ+vG0="</DigestValue>
</Reference>

<Reference URI="meta.xml">
<Transforms>
  <Transform Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
</Transforms>
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>1fAh4stpvpS2v+Vwsj3tjCjDCak="</DigestValue>
</Reference>

<Reference URI="Thumbnails/thumbnail.png">
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>fhbAJvPqzcJVM0ge79JhlWJX49k="</DigestValue>
</Reference>

<Reference URI="settings.xml">
<Transforms>
  <Transform Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
</Transforms>
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>LozqLt1yQvg6a2UVdza4IUC1p5Y="</DigestValue>
</Reference>

<Reference URI="#ID_00f500ab00ef00d800eb00ec0040003400"/>
In the second method, the macro tree only is signed (including the macros). This is another major design weakness since documents signed in this way can be partially modified while the user is not aware of the fact that only the part relevant to macros are actually signed.

---

META-INF/macrosignatures.xml file content

---

43
Finally, let us stress on the fact that the documentsignatures.xml is itself not signed.

3 Viral Attacks Through Plain OpenOffice Documents

There absolutely no significant changes compared to the previous version [2]. Simple archive manipulations (using zip/unzip utility and a simple text editor) enable to perform a lot of attacks.

If we intend to modify the document payload itself (the document visible text), the principle consists in modifying the information contained within the suitable tags. As an example, you can modify the content within the <text> tags in the META-INF/manifest.xml file. Since no integrity check is performed.
performed, the modification remains unnoticed by the user.

To illustrate this, we modify the following original file at the `content.xml` file level

**Orginal content.xml file (extract)**

```xml
<?xml version="1.0" encoding="UTF-8"?>
</office:document-content>
```

It is possible to modify any other format description data (XML file description) in the same way. We will not describe the possible attacks through unprotected (encryption and/or signed) documents. There is nothing new compared to OpenOffice.org version 2.x [2]. Among many other possibilities, the main powerful attack can then

- add non declared file (in particular one or more malicious macros). This is particularly interesting when considering data (file) theft. It is possible to insert stolen data into an OpenOffice.org file.

- macro substitution (replace macros with other malicious macros). This is the core approach for any malware attack.
From a technical point of view, the main point is to respect the XML structure and syntax in the file. Any incorrect modification will be detected during the XML parsing step. Any XML compliant modification will remain undetected.

4 Viral Attacks Through Encrypted OpenOffice Documents

In this section as well as in Section 5 we are going to explain how to exploit the users' trust in cryptographic primitives that are apparently enforced by OpenOffice.org. The core approach is to modify encrypted/signed document to fool the users in such a way that no encryption bypassing or integrity violation has apparently occurred. In the case of encrypted documents, the user must still use his password to access the document while it has been infected during the transmission.

4.1 Critical Aspect of the Content.xml File

We have performed a lot of experiments in order to transparently bypass the encryption. As a general conclusion, as soon as the content.xml file is modified – or any XML information related to it, for example in the manifest.xml file –, the modification/attack partly or totally fails: either the document opening crashes or no password is required. In the latter case, even if the user succeeds in opening the document, the absence of password request is generally bound to trigger an alert in the user’s mind since the document is supposed to be encrypted. Aside the critical impact of the content.xml file, a few other manipulation of encrypted documents seemed to failed while the latter file was not concerned. As an example, we failed to simply replace the current.xml file only.

Consequently there are a few significant differences compared to the previously identified weaknesses for OpenOffice.org version 2.x [6]. But those differences have a limited impact or no impact at all for all the other attacks.

However when trying to understand why some of those attacks failed while they were successful for the OpenOffice version 2.x, we discovered that the related difference was rather less significant than expected. In a first time, we detected a difference between a document produced by the application and a document forged by hand (or by a malware). The most surprising point lies in the fact that both seemingly have the same content.
This clearly proves that there exist some additional information within the archive that have a significant impact. Let us recall that encrypted files cannot be compressed further (since the entropy is quite optimally reduced).

Now every file in an encrypted archive are themselves encrypted with the noticeable exception of the META-INF/manifest.xml file. The comparison of both archive contents unveils the difference.
While the total size of the files in both doc_manual_zip_1.odt and doc_application.odt archives are the same, five extra files are present in the first one, which constitutes a significant difference. To successfully bypass encryption, we suppose that we have to recreate the archive by hand (or by a malware) in such a way that those five extra files are not present. Instead of using the formerly efficient command (for OpenOffice.org 2.x)

`zip -r ../doc.odt *`

we now use the following command instead

`zip -r -x Configuarations2/ Configurations2/accelerator/ \  
 Configurations2/images/ META-INF/ Thumbnails/ /doc.odt *`

The result is a success as long as we do not modify the content.xml file.

### 4.2 Successful Attacks Through Encrypted OpenOffice 3.x Documents

Still a large number of attacks remains possible by means of encrypted OpenOffice 3.x documents. Due to lack of space, we will not details of of them. Figure 6 summarizes all of them (green cells), along with those
which now are failing (pink cells) while they were successful for OpenOffice 2.x [6].

We are going to focus on the most interesting one with respect to malware attacks: replacing all encrypted macros with malicious (of course unencrypted) macros. Whenever the intended recipient opens the infected, encrypted document, the latter asks for a password in the same way as it would for a clean, non infected archive. Everything looks correct and the recipient’s trust in encryption turns against him. We will not cover the trivial case of inserting such malicious macros into an encrypted OpenOffice 3.x document without macro. This is performed very easily by first inserting the macro themselves and creating their references into the archive (in particular in the **manifest.xml** file) without forgetting to strictly comply to the XML syntax and structure.

Let us consider then the case which consists in replacing an encrypted macro with a plaintext (malicious) macro. First the original encrypted macro is simply replaced with the code of a malicious macro we intend to use for our attack:

Malicious substituted macro

```xml
<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE script:module PUBLIC "-//OpenOffice.org//DTD OfficeDocument 1.0//EN" "module.dtd">
  REM ***** BASIC *****
  Sub Main
    msgbox("Hello man, I'm the Gremlins hehehehe !!!")
  End Sub
</script:module>
```

In a next step, we modify the META-INF/manifest.xml file to remove the encryption reference with respect to the macro only. For that purpose, we remove the following lines:

```xml
<manifest:encryption-data manifest:checksum-type="SHA1/1K"
  manifest:checksum="emEQ5qqz7rZWFM0AHmS928kWs=">
  <manifest:algorithm manifest:algorithm-name="Blowfish CFB"
    manifest:initialisation-vector="tEhzORcLiHY="/>
  <manifest:key-derivation manifest:key-derivation-name="PBKDF2"
    manifest:iteration-count="1024"
```
Figure 6: Summary of attacks through encrypted OpenOffice 3.x documents
and we modify the line

```xml
<manifest:file-entry manifest:media-type="text/xml"
    manifest:full-path="Basic/Standard/Mess.xml" manifest:size="368">
```

Once the META-INF/manifest.xml has been modified, the archive is rebuilt. At the opening the password is requested and the document successfully opens while the malicious macro operates.

We can perform far more sophisticated attacks by replacing the whole tree of encrypted macros with a complete tree of malicious macros. The principle remains quite the same. We have to modify the manifest.xml file in such a way that we remove every reference to encryption with respect to any part of the macro tree.

## 5 Viral Attacks Through Digitally Signed OpenOffice Documents

From the different data presented in Section 2.3.4, it follows that most of the attacks that have been indentified in [6] are no longer valid for most of them. Let us summarize them:

- add macro to a signed document,
- replace macro with another macro.

But since critical files are not encrypted and especially there is no external secure management of digital signature keys and certificate (use of PKI), it is dramatically easy to forge fake X509 certificate and play man-in-the-middle attacks:
1. Alice the sender signs her document and sends it to the legitimate recipient Bob.

2. Charlie the attacker intercepts the message and gets rid of the signature. Then he forges a fake Alice’s certificate and public key and then impersonates Alice by signing the document as she would do. Let us note that Charlie could directly produce such a malicious document instead of intercepting an existing one. In both cases, Charlie sends the document to Bob in Alice’s place (impersonation attacks).

3. Bob the recipient verifies the signature supposedly put by Alice. Everything is OK and Bob trusts in the document. Charlie’s attack is successful simply by turning the signature confidence against Bob.

Let us now detail those three steps.

5.1 Step 1: Alice Signs Her Document

As in any signature scheme, Alice has first to produce her public/private keys and X509 certificate. When checking the validity of the certificate, the OpenOffice application displays the following information to Alice (Figure 8 on left). More detailed information about it are available as well (Figure 8 on right). When checking the certificate, we obtain what Figure 7 displays.

Let us recall that Charlie can retrieve all this information by simply checking any document signed by Alice. This information will be very useful to him in order to forge a fake Alice’s certificate.

5.2 Step 2: Charlie forges Alice’s signature

Let us recall that Charlie can retrieve all those information by simply checking any document signed by Alice. Those information will be very useful to him in order to forge a fake Alice’s certificate.

From a practical point of view, Charlie needs a lot of Alice’s personal data to forge this certificate. Two different files in an OpenOffice archive are then critical. The first one is the meta.xml file which contains generic data about the signer. The second one is either the documentsignatures.xml file or the macrosignatures.xml depending on the method used to sign the document (see Section 2.3.6).

5.2.1 Recovering Alice’s personal data

Here are the different steps to be performed by Charlie:
1. Unzip any document signed by Alice with the command `unzip -d AliceForBob.dir AliceForBob.odt`.

2. Extract generic Alice’s data from the `meta.xml` file.

    Alice's generic data

    ```xml
    <?xml version="1.0" encoding="UTF-8"?>
Figure 8: Alice's certificate (general) (left) - Alice's certificate (detailed view) (right)
Alice's generic data II

<?xml version="1.0" encoding="UTF-8"?>
We then recover the following data:

- **the email address** in the \( E= \) field,
- **the usual surname** in the \( CN= \) field,
- **the organisation or company department** in the \( OU= \) field,
- **the organisation or company name** in the \( O= \) field,
- **the town** in the \( L= \) field,
- **the state (USA) or province (other)** in the \( ST= \) field,
- **the country** in the \( C= \) field.

### 5.2.2 How to forge the signature

From the data collected, Charlie is now able to forge a new certificate to impersonate Alice’s identity as well as a new public/private keys pair. He first has to generate a X509 certificate by using the command:
openssl req -newkey rsa:1024 -x509 -keyout CharlieKeys.pem
- out CharlieCert.cert

Then Charlie export the X509 certificate to the PKCS#12 format with the command:

openssl pkcs12 -export -in CharlieCertX509.pem
- inkey CharlieKeys.pem -out CharlieCertX509.p12

Charlie then chooses a passphrase (as Alice would do) to activate Alice’s (fake) private key. Finally Charlie adds the forged certificate in the Firefox certificate path and signs the document as Alice usually do.

5.2.3 Charlie generates a malicious signed document

Charlie opens Alice’s document with OpenOffice, copies its content and paste it into a new document. Then he adds a malicious macro (see Figure 9). Then he signs the new document using Alice’s forged signature.

![Figure 9: Charlie adds a macro](image)
Figure 10: Charlie signs the document

Figure 11: Charlie signs the document (II)
Figure 12: Detail of the forged certificate

Figure 13: Charlie signs the document (III)
Figure 14: Charlie’s final (malicious) document

Figure 15: Certificate as seen by Bob
5.3 Step 3: Bob Checks Alice’s Signature

Once Bob has received the document sent by Alice, he opens it and sees that it is apparently signed by Alice. Then he checks Alice’s certificate (Figure 15).

Advanced checking confirms that the document actually is signed by Alice (Figures 16 and 17). Nothing can alert Bob that the document has actually not been signed by Alice unless he compares the true Alice’s public key (that he has previously stored) with the forged key.

Figure 16: Detailed view of the certificate as seen by Bob (I)
5.4 A Close Look at Certificates

Let us now have a closer look directly at the certificates to identify the differences

Alice's certificate

<?xml version="1.0" encoding="UTF-8"?>
<document-signatures xmlns="urn:oasis:names:tc:opendocument:xmlns:digitalsignature:1.0"><Signature xmlns="http://www.w3.org/2000/09/xmldsig#" Id="ID_004100b600e2007303f003b0044001300b50089001300ab00ed001500280078">
  <SignedInfo>
    <CanonicalizationMethod Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
    <SignatureMethod Algorithm="http://www.w3.org/2000/09/xmldsig#rsa-sha1"/>
    <Reference URI="Configurations2/accelerator/current.xml">
      <DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
    </Reference>
  </SignedInfo>
</Signature></document-signatures>
<?xml version="1.0" encoding="UTF-8"?>
<document-signatures xmlns="urn:oasis:names:tc:opendocument:xmlns:digitalsignature:1.0">
<Signature xmlns="http://www.w3.org/2000/09/xmldsig#" Id="ID_005f004b001e0070000f00eb004200720081003300ff005d002b0088009e0064">
  <SignedInfo>
    <CanonicalizationMethod Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
    <SignatureMethod Algorithm="http://www.w3.org/2000/09/xmldsig#rsa-sha1"/>
    <Reference URI="Configurations2/accelerator/current.xml">
      <DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
      <DigestValue>2jmj7l5rSw0yVb/vlWAYkK/YBwk=</DigestValue>
    </Reference>
    <Reference URI="content.xml">
      <Transforms>
        <Transform Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
      </Transforms>
      <DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
      <DigestValue>QCP8G2JsaWUm4txZoqB69HKhy4U=</DigestValue>
    </Reference>
    <Reference URI="Basic/Standard/MaliciousMacro.xml">
      <Transforms>
        <Transform Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
      </Transforms>
      <DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
      <DigestValue>9AxtmQVMkaMwIzw+pyRQmK2Pwhs=</DigestValue>
    </Reference>
  </SignedInfo>
</Signature>
</document-signatures>
<Reference URI="Basic/Standard/script-lb.xml">
<Transforms>
  <Transform Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
</Transforms>
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>Oj1iqlqXmednVoN53MCVxYHOAAE=
</DigestValue>
</Reference>
<Reference URI="Basic/script-lc.xml">
<Transforms>
  <Transform Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
</Transforms>
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>xebeZZyd10w0yLL6wp9QELP1+UEY=
</DigestValue>
</Reference>
<Reference URI="styles.xml">
<Transforms>
  <Transform Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
</Transforms>
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>6j3xV9oFUv9fjp6Stt0iKD+vG0=
</DigestValue>
</Reference>
<Reference URI="meta.xml">
<Transforms>
  <Transform Algorithm="http://www.w3.org/TR/2001/REC-xml-c14n-20010315"/>
</Transforms>
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>jj3b9+WEJzgDs+JM/r1YznYHRQ=
</DigestValue>
</Reference>
<Reference URI="Thumbnails/thumbnail.png">
<DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<DigestValue>9b0t2UV8E10TWSXYv39IfIp40M=
</DigestValue>
</Reference>
5.5 Conclusion

The attack is not only very efficient but also completely transparent for Bob. Charlie has forged a fake certificate with the help of Alice’s collected data. He has also generated a pair of public/private keys and has just to impersonate Alice’s identity. He will additionally modify a few data in the meta.xml file to play the attack more efficiently but it is important to mention that those data are not taken into account whenever the signature is verified by Bob. Those data modifications just intend to manage more suspicious recipients. Finally, any operation performed by Charlie can be automated by a malware.

6 Conclusion: Enhancing OpenOffice Security

From all the study presented in this paper, it is clear that at the present time it is still to bypass cryptographic protections in OpenOffice 3.x and more worringly to turn them against the users to mount powerful malware attacks using the the confidence put in cryptography. Moreover, the “natural” confidence in free software as well as their attractivity both for technical and ideological reasons, could result in a dramatical underestimation of the risk attached to malware attacks.

At the present time, the use of OpenOffice documents for official use or critical use should be postponed until the suite manages security in a more acceptable way. But it is likely that targeted attacks will rise using the design weaknesses of the suite.
Is it possible to enhance OpenOffice security. The question is definitively positive provided that there is a will to do it. The best solution should be to consider the suggestion we made in [6, 5] to produce a trusted OpenOffice suite in which any site administrator could configure/disable/enable some features with respect to the security policy in place. A simple administrator password would be necessary. This would enable to disable macros as an exemple or to add proprietary plug-in for a better integrity management.

But it is also possible to change some aspects which would contribute to enhance the security. The list given hereafter is probably not exhaustive but it relates to some very important points:

- whenever cryptographic protections are used, the manifest.xml and meta.xml files, as well as any other critical files, should be better protected (encrypted). This would prevent the attacker to access the internal structure of the archive and to manipulate it;

- in a more formal way, there is no semantic verification of the archive. The application is just performing a syntactic verification of the XML specification. Such a semantic verification should be considered and implemented.

As far as signature is concerned, there is no efficient protection possible without a public key infrastructure or something equivalent. This means that unless the OpenOffice project proposes an offer equivalent to what Microsoft is itself doing, no true efficient security will be possible. Archive manipulation and man-in-the-middle attacks will be otherwise always possible. The other solution is probably to close some parts of the application but this is clearly against the free software philosophy. As soon as any system is totally open to any user, it is also open to any attacker. There is no other solution to break that duality than at least partially closing what relates to security.

References


[10] OpenOffice website, http://www.openoffice.org/dev_docs/features/3.0/#ODF_1.2_support,